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 techniques that can help you to set up a 
effectively.
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n choose either of the following 

you set all options for your meeting. These 
eting information, recurrence, 
dee list, registration, agenda, attendee 
, and other meeting details.

 set a smaller number of options for your 
lude basic meeting information, 
ttendee list.

g

You can provide security for your meeting by doing any of the 
following in the Advanced Scheduler:

assword for the meeting, attendees 
 meeting.

ted meeting does not appear on the 
nter Web site. To join an unlisted 
sted link under Attend a Meeting on 
que meeting number.
eeting Center Web site.

he tips and techniques in this guide were provided by meeting 
ers like yourself. If you have a tip that you want to share with 
rs, please send a detailed description of your tip to 
bex.com.
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t this guide

l WebEx Meetings provides tips and techniques that you can 
duct more effective meetings on the Web. This guide assumes 
re already familiar with the basics of Meeting Center, and 

es not provide detailed instructions for using Meeting Center.

Setting up a mee

For meeting hosts

This section provides tips and
scheduled or instant meeting 

Choosing a schedule

To schedule a meeting, you ca
schedulers:

■ Advanced Scheduler: Lets 
options including basic me
teleconferencing, the atten
privileges, security options

■ Quick Scheduler: Lets you
meeting. These options inc
teleconferencing, and the a

Securing your meetin
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 recurrence options on the Date 
ler.

e

 select one of the following 
 Quick Scheduler or Advanced 
the Advanced Scheduler, click 
uick Scheduler, click Change 

 not need to set up a formal 
ncing service—for example, if you want 
dee.

hedule a meeting without using a 
 is recommended that you clearly specify 
w you plan to provide audio for the 
ees may not realize that your meeting 
 inform attendees that you will call them 
is information, you can create a custom 
ting a custom email invitation for 

■ WebEx teleconferencing service: The meeting includes an integrated 
teleconference. If you select this option, select one of the following types 
of teleconferences:

tion to have attendees call a phone 
e. 

elect this option to have the 
tendees to connect them to the 
cheduling a recurring meeting

 you want to host a meeting on a regular basis, you can specify one of 
e following recurrence patterns when scheduling a meeting using the 
dvanced Scheduler:

Daily recurrence

Weekly recurrence

Monthly recurrence

Yearly recurrence

Attendees call in: Select this op
number to join a teleconferenc

Attendees receive a call back: S
teleconferencing service call at
teleconference.
Exclude the meeting password from email invitations: If you have 
specified a meeting password, you can prevent the password from 
appearing in the email invitations that your Meeting Center Web site 
automatically sends to attendees. 

Require attendees to log in: You can require that attendees have a user 
account on your Meeting Center Web site. Thus, attendees must log in to 
your site before they can attend a meeting.

Require attendees to register for the meeting: You can require each 
attendee to fill out a registration request that includes his or her name, 
email address, and other information that you require, and then send the 
request to you. You can then accept or reject each registration request.

he level of security that you choose depends on the meeting's 
rpose. For example, if you schedule a meeting to discuss your 
mpany picnic, you might specify only a simple password for the 
eeting. On the other hand, if you schedule a meeting in which you 
ill discuss sensitive financial information, you may want to specify 
at the meeting is unlisted and require attendees to log in to your site 
 attend.

N o t e  Once you start a meeting, you can provide additional 
security by “locking” the meeting. For details, see Preventing 
unauthorized access to a meeting in progress on page 6.

To set up a recurring meeting, specify
& Time page in the Advanced Schedu

Including a teleconferenc

When scheduling a meeting, you can
teleconferencing options in either the
Scheduler. To access these options in 
Teleconference on the right; in the Q
audio option.

■ None: Select this option if you do
teleconference or use a teleconfere
to meet with only one other atten

I m p o r t a n t  If you sc
teleconferencing service, it
in your email invitation ho
meeting; otherwise, attend

includes audio. For example, you can
once the meeting starts. To specify th
email invitation. For details, see Crea
attendees on page 4.
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When scheduling a meeting, you can choose to use Integrated VoIP in 
addition to or instead of a teleconference. This option allows attendees 
to
te
In

■

■

 conference does not start automatically 
 must start the Integrated VoIP 

 Tools menu, point to Integrated VoIP, 

on about using Integrated VoIP, 
ts, refer to the online Help on your 

ndees

e Advanced Scheduler, you can 
om attendees, using the options 
privileges that you select 
share documents, view shared 
shared documents, and so on. 

d that you accept the default 
privileges as needed to all 
ing the meeting. That way, you 

can maintain more control over the meeting. For example, if you are 
giving a presentation and want to ensure that attendees follow along 
with your slides, you probably do not want to grant them the View any 

ate your presentation 

eeting before its scheduled 

u can let attendees join a meeting 
le, you can specify that attendees 
efore its scheduled starting time. 
 Date & Time page in the 

 attendees from having to wait for 
an join it.
 speak to each other using voice over IP (V0IP)—an Internet-based 
lephony service—rather than the traditional telephone system. 
tegrated VoIP can be useful in the following cases:

Your meeting includes remote attendees who do not want to be charged 
for long-distance phone calls. 

Your meeting will not involve much interaction—for example, attendees 
will listen to a presentation instead of engage in a discussion.

page privilege, which lets them navig
independently.

Letting attendees join a m
starting time

If you use the Advanced Scheduler, yo
before you actually start it. For examp
can join a meeting up to 10 minutes b
This option, which is available on the
Advanced Scheduler, helps to prevent
you to start the meeting before they c
I m p o r t a n t  In a call-back teleconference, only meeting 
attendees who have direct phone lines can receive a call back from the 
teleconferencing service. If a receptionist answers the call from the 

rvice, or the attendee's phone system uses a recorded greeting for incoming 
lls, the attendee cannot receive a call back. However, an optional call-in 
one number for the teleconferene is always available in the Meeting 

indow.

Personal Conference Number: Available only if your user account 
includes the Personal Conference Number option. Select this option to use 
your Personal Conference Number account for the teleconference. With a 
PCN account, you can use the same conferencing numbers for all your 
meetings and set the access codes that you want to use to start the 
teleconference, and the access codes that you want attendees to use to join 
the teleconference.

Other teleconferencing service: Select this option if you want to use 
another teleconferencing service provider or an internal teleconferencing 
service. If you type instructions for joining the teleconference in the box 
that appears, the instructions automatically appear in a message box once 
an attendee joins the meeting.

cluding an Integrated VoIP conference

N o t e  An Integrated VoIP
once you start a meeting. You
conference as follows: On the

and then choose Start Conference.

N o t e  For more informati
including system requiremen
Meeting Center Web site.

Granting privileges to atte

When scheduling a meeting using th
grant privileges to or remove them fr
on the Attendee Privileges page. The 
determine whether all attendees can 
documents independently, annotate 

For most meetings, it is recommende
privileges, and then grant additional 
attendees or individual attendees dur
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then click Save As Template at the bottom of the scheduling page. The 
next time you want to schedule a meeting, simply choose the template 
from the Set options using template drop-down list at the top of the 
A
m
to

vitation for attendees

en scheduling it, Meeting Center 
messages to the attendees. 
tic email message, as follows: 

eeting. Once you receive the 
dify it as needed, and then 
m invitation email message, 
meeting information that the 
e date and time for the meeting, 

ing the meeting, and voice 

eeting confirmation email message 
e contains information and URLs that 
.

ut a scheduled meeting

t a meeting, including its starting 
ited attendees. Once you modify 

tendees a new invitation email 
ave modified information about 

the meeting. Attendees whom you removed from the attendee list 
receive an email message informing them that you have retracted their 
invitations.

dule a meeting on your 

ore meeting service users to 
nce another user schedules a 
 in your list of meetings on the 
en start the meeting and host it 

ule meetings yourself. 
dvanced Scheduler or Quick Scheduler page. Before you schedule the 
eeting, you can change any of the options that the template applied 
 your meeting.

Letting another user sche
behalf

You can grant permission to one or m
schedule meetings on your behalf. O
meeting for you, the meeting appears
My WebEx Meetings page. You can th
as you normally can when you sched
 you do let attendees join a meeting early, you can automatically share 
presentation or document once an attendee joins the meeting. For 
tails, see Sharing a presentation automatically on page 4.

haring a presentation automatically

 you let attendees join a meeting before its scheduled starting time 
ing the Advanced Scheduler, you can share a presentation or 
cument automatically. The presentation or document can inform or 
tertain attendees while they are waiting for you to start the meeting.

 share a presentation or document automatically, you must select it 
hen scheduling a meeting. The presentation or document must be in 
e WebEx Universal Communications Format (UCF). To save any 
cument or presentation as UCF, use the WebEx Universal 

ommunications Toolkit or the WebEx Document Manager, which are 
ailable on the Support page on your Meeting Center Web site.

sing meeting templates

 save time when scheduling a meeting, you can set up a meeting 
mplate. A meeting template automatically sets all the options your 
eeting, except the password and date and time options. 

 set up a meeting template, use the Advanced Scheduler or Quick 
heduler top set the options you want to use for your meetings, and 

Creating a custom email in

If you invite attendees to a meeting wh
automatically sends invitation email 
However, you can modify the automa
Initially invite only yourself to the m
invitation email message, you can mo
forward it to attendees. In your custo
ensure that you include all necessary 
original message contained, such as th
the meeting agenda, the URL for join
conferencing information.

N o t e  Do not modify the m
that you receive. This messag
you need to host the meeting

Updating information abo

You can update any information abou
time, recurrence pattern, or list of inv
a meeting, you can choose to send at
message that informs them that you h
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To set up One-Click Meeting shortcuts, do either of the following on 
your Meeting Center Web site

■

■

S

Fo

T
a 

ting

t their scheduled times. As the 
eeting before attendees can join 

start a meeting about 10 minutes 
ccommodate any attendees who 

in a meeting before you actually 
matically becomes “open” at a 
g it. For more information, see 
 its scheduled starting time on 

 your Meeting Center Web 

 Meeting Center Web site to join 
he correct URL. Some common 

 Center Web sites do not include the 
ites include your organization's name, 

x.com

■ Typing webx instead of webex in the URL.

■ Typing http instead of https, if your site is secured with SSL (Secure 
Sockets Layer). A secure site's URL uses this format:

webex.com

 a meeting

eting, they may be attempting to 
tarted. On the meeting calendar 

der Status, the text Join Now and 
u start the meeting. Otherwise, 
Click My WebEx > My Meetings > One-Click Setup

On the navigation bar, click Host a Meeting > One-Click Meeting.

tarting and conducting a meeting

r meeting hosts

his section provides tips and techniques for starting and conducting 
meeting.

https://<your_organization_name>.

Helping attendees to join

If attendees have trouble joining a me
join a meeting that you have not yet s
on your Meeting Center Web site, un
a green indicator appear only after yo
the text Not started appears
 let another user schedule a meeting for you, specify that user in your 
er profile on your Meeting Center Web site. You can select only a user 
ho has an account on your Meeting Center Web site.

sing Microsoft Outlook to schedule a meeting

 you use Microsoft Outlook 2000 or later, and your Meeting Center 
nfiguration includes the WebEx Integration to Outlook option, you 
n schedule, start, and join online meetings using Microsoft Outlook. 
r instructions on using Integration to Outlook, refer to the guide 
ebEx Integration to Outlook User's Guide. This guide is available on 
e Support page on your Meeting Center Web site.

sing One-Click Meetings

 you often meet with others to spontaneously collaborate on 
cuments, spreadsheets, and so on, you can set up One-Click Meeting 
ortcuts for your Microsoft Office applications. Then, while working 
 a Microsoft Office application, you can instantly start a meeting and 
are the document that is open in that application.

milarly, you can set up a One-Click Meeting shortcut for your 
indows shortcut menu. This shortcut lets you right-click any 
cument or application on your computer to instantly start a meeting 
d share that application or document in the meeting.

Starting a scheduled mee

Meetings do not start automatically a
meeting host, you must first start a m
it. Thus, it is recommended that you 
before its scheduled starting time, to a
want to join a few minutes early.

Alternatively, you can let attendees jo
start it. In this case, the meeting auto
time that you specify when schedulin
Letting attendees join a meeting before
page 3.

Helping attendees to find
site

If attendees have trouble finding your
a meeting, verify that they are using t
mistakes that users make:

■ Typing www in the URL. Meeting
www server name. Instead, these s
in the following format:

http://<your_organization_name>.webe
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for joining the teleconference automatically appear in a message box 
on an attendee’s screen once that attendee joins the meeting. Attendees 
can also obtain instructions for joining a teleconference at any time 
du
Pa
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 Integrated VoIP, then choose 

ed VoIP conference, you can use 
ailable on the Communicate 
ne and speakers are set to their 

on about using Integrated VoIP and the 
the online Help on your Meeting Center 

on

ques for sharing presentations 
nd recording meetings.

g

lems and ensure that your 
meeting runs smoothly:

■ Before you start a meeting, ensure that your computer and network are 
expected problems during the meeting.

o share in a single folder, so you can 
eeting

tice sharing the documents and 
are with attendees. That way, you can 
 attendees join the meeting.

your backup meeting site handy, in case 
f you do not know the URL for your 
ter site administrator.
ring the meeting, by choosing Join Teleconference on the 
rticipant menu. If your meeting includes an integrated call-in 

leconference, the call-in number also appears on the Info tab in the 
ntent viewer.

sing Integrated VoIP

, when scheduling or starting an instant meeting, you included an 
tegrated VoIP conference, you must start the conference after you 
art the meeting:

working properly to avoid any un

■ Place all the files that you intend t
quickly locate them during the m

■ Start your meeting early, and prac
applications that you intend to sh
troubleshoot any problems before

■ Ensure that you have the URL for 
your primary site is unavailable. I
backup site, ask your Meeting Cen
ecause a meeting’s status can change at any time, an attendee can 
riodically click the Refresh button on the page to determine whether 
u have started the meeting.

u can help to avoid the need for attendees to refresh the meeting 
lendar by letting them join the meeting before you actually start it. 
r details, see Letting attendees join a meeting before its scheduled 

arting time on page 3.

reventing unauthorized access to a meeting in 
rogress

nce all required or invited attendees have joined a meeting, you can 
ock” the meeting by restricting access to it. Restricting access to a 
eeting prevents anyone else from joining it. To lock a meeting, choose 
estrict Access on the Meeting menu. 

elping attendees to join a teleconference

 your meeting includes an integrated call-in or call-back 
leconference, or a third-party teleconferencing service, instructions 

On the Communicate menu, point to
Start Conference.

Before starting or joining an Integrat
the Audio Setup Wizard—which is av
menu—to ensure that your micropho
optimal levels.

N o t e  For more informati
Audio Setup Wizard, refer to 
Web site. 

Presenting informati

For presenters

This section provides tips and techni
and applications, polling attendees, a

Preparing for your meetin

These tips can help you to avoid prob
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View Floating Video Window button:

Vi
bu

cation, use the annotation tools 
ize points, and draw and write 
g with few attendees, you might 
our shared presentation or 
tion tools, for example, to point 
ant to comment or ask a 

tation tools appear above the 

ng an application, in the title bar 
aring button, and then choose 

nnotation tools
ew Floating Video Panel 
tton

To access annotation tools while shari
of the shared application, click the Sh
Start Annotation.
Once you start a meeting, write down the meeting number, host key, and, 
if you are using the integrated teleconferencing service, the teleconference 
number. These numbers appear on the Info tab in the content viewer

sing an assistant presenter

 you want to focus on speaking during a meeting, or want to view 
ur presentation from an attendee's perspective, you can assign the 
esenter role to another attendee. This attendee can “drive” the 
esentation, by advancing slides and sharing applications as you need 
em.

ersonalizing your meeting with video

 you attach a video camera to your computer, you can use video to 
troduce yourself at the beginning of a meeting. To send live video to 
rticipants, simply open the Video panel in the Meeting window.

aking a snapshot of video

 you want participants to see your image during a meeting, you can 
ke a snapshot of your video image, and then paste it on a whiteboard 
 the content viewer. That way, you can close the Video panel, thereby 
ving bandwidth and improving the performance of Meeting 
anager. To take a snapshot of video, on the Video panel, click the 

Then click the Take Snapshot button:

Using annotation tools 

When sharing a presentation or appli
to highlight text or graphics, emphas
notes. If you are conducting a meetin
want to allow attendees to annotate y
application. Attendees can use annota
to areas on a slide about which they w
question.

When you share a presentation, anno
content viewer:

Take Snapshot button

A
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and then share the application. Sharing a presentation or document as an 
“application” lets you or an attendee edit the slides or pages during the 
meeting.

■

aring Web pages

eb pages to attendees in one of 

er sharing allows you to take attendees 
w each Web page that you access, either 

zation’s private intranet. You can 
rol your Web browser. This option uses 
g two options.

Web page on the Internet that includes 
 and animation, you can use Web 
ou specify a URL for a Web page, video, 
cording, and display the content in the 
 screen. Attendees can hear sounds and 
ects independently in their content 
share a single Web page more quickly 
ser sharing option; however, it does not 
her Web pages.

ebEx Universal Communications 
Web page directly in a Microsoft 
ou share the presentation in the content 
e Presentation or Document command 
 automatically appears on the slide on 
ption is useful if you want to include a 

Web page in your presentation but do not want to stop your presentation 
to use either Web browser sharing or Web content sharing. For more 
information about creating and sharing presentations in which you insert 

timedia to enhance your presentation on 
Sharing a presentation or document by sharing your desktop: Sharing 
your desktop provides the same benefits as sharing your presentation as an 
application. However, desktop sharing lets you show any part of your 
desktop to attendees and quickly share additional applications.

media objects, see Using UCF mul
page 10.
he Tools panel appears:

hoosing an option for sharing presentations or 
ocuments

eeting Center provides the following options for sharing a 
esentation or document: 

Sharing a presentation or document in the content viewer: The 
Presentation or Document command on the Share menu displays a 
presentation or document in the content viewer. If you used Microsoft 
PowerPoint to create your slides, the content viewer also displays any 
animations and transitions on the slides. This sharing option provides a set 
of annotation tools that both you and attendees with annotation privileges 
can use; viewing options, such as thumbnails and full-screen view; and 
simultaneous use of the entire Meeting window, including the participant 
list and chat.

Sharing a presentation as an application: Instead of displaying a 
presentation or document in the content viewer, you can open the 
presentation or document in the application with which it was created, 

Choosing an option for sh

During a meeting, you can display W
three ways:

■ Web browser sharing: Web brows
on a “Web tour.” Attendees can vie
on the Internet or on your organi
optionally allow attendees to cont
more bandwidth than the followin

■ Web content sharing: To share a 
multimedia effects, such as sound
content sharing. This option lets y
audio file, flash file, or WebEx Re
content viewer on each attendee’s
interact with other multimedia eff
viewers. This option also lets you 
than you can using the Web brow
allow you to guide attendees to ot

■ Presentation sharing: Using the W
Toolkit, you can insert a link to a 
PowerPoint presentation. When y
viewer during a meeting, using th
on the Share menu, the Web page
which you inserted its link. This o
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All attendees’ content viewers then display the page or slide at the same 
magnification that you set in your viewer.

Im
p

Yo
at

■
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0 slides in one presentation file. If you 
 a separate presentation file for each set of 

 file to a maximum of 5 MB.

ons and Transitions

int slide presentation in the 
ations on the slides and slide 

ion, you can perform slide 

ewer to set the input focus. A blue border 
s that the viewer has input focus.

nsition or animation, click the Next Page 

■ To perform the previous slide transition or animation, click the 
Previous Page button on the toolbar.

 display animations or slide transitions, 
esentation using the Universal 

CF) import mode: On the Meeting 
k the Import Mode tab.

age button
proving the performance of document or 
resentation sharing

u can improve the speed at which shared pages or slides appear to 
tendees using these techniques: 

Limiting the number of animations and slide transitions that you add to 
Microsoft PowerPoint slides.

Minimizing the number of screen captures that you add to slides, 
especially if they are bitmap graphics. Such graphics do not compress well.

N o t e  If you are unable to
ensure that you import the pr
Communications Format (U

menu, choose Options, and then clic

Previous Page button
Providing handouts to attendees

You can let attendees print handouts at any time during a meeting, as 
follows:

1 Share the handout by choosing Presentation or Document on the Share 
menu, and then selecting the handout document.The handout appears in 
the content viewer.

2 On the Participant menu, choose Privileges.

3 In the Attendee Privileges dialog box, select the Print check box, and then 
click Assign.

Attendees can now print the shared handout by pointing to Print on 
the File menu, and then choosing Document.

Synchronizing displays

When you share a document or presentation in the content viewer, 
some attendees may not be able to view the entire page or slide that you 
are sharing, because their viewers are set to different magnifications. To 
resolve this problem, simply click the Sync Displays for All button on 
the toolbar at the bottom left corner of the Meeting window.

■ Not including more than 20 to 3
want to share more slides, create
20 to 30 slides.

■ Keep the size of the presentation

Displaying Slide Animati

When sharing a Microsoft PowerPo
content viewer, you can display anim
transitions.

After you begin sharing a presentat
transitions or animations:

1 Click anywhere in the content vi
around the shared slide indicate

2 Do either of the following:

■ To perform the next slide tra
button on the toolbar

Next P
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with attendees by copying it to 
 pasting it in the content viewer. 
wing:

ge or in a document, and then choose 

r desktop to an image by pressing the 

 image by pressing the PrtScn (Print 

puter's clipboard, on the Edit 
e Paste as New Page.

e content viewer, such as a GIF, 
you cannot paste other types of 
shop (PSD) images—in the 

red views

mon problems with application, 

■ Differences in screen resolution settings between your computer and an 
attendee's computer may prevent that attendee from viewing the entire 
application, desktop, or Web browser that you are sharing. To help avoid 

e following:

age of the shared software, by clicking 
r-right corner of the sharing window, 
cting an option.

onitors to the same screen resolution as 

reen resolution, such as 800 by 600 
o t e  For more information about creating UCF multimedia 
esentations, refer to the guide Getting Started with WebEx Universal 

ommunications Toolkit. For more information about sharing either 
UCF multimedia presentation or a standalone media file, refer to the online 
elp on your Meeting Center Web site.

this problem, you can do any of th

Ask attendees to reduce the im
the Sharing button in the uppe
pointing to View, and then sele

Ask all attendees to set their m
your screen.

Set your monitor to a lower sc
pixels. 
sing UCF multimedia to enhance your presentation

u can make an online meeting more engaging by sharing these types 
 media files in the content viewer:

WebEx Recording Format (WRF) files

Video files

Audio files

Flash movie and interactive Flash files

Web pages

 share a media file, you must use a Universal Communications 
rmat (UCF) media object. A media object links to the media file and 
ovides a window in which the file appears. An object also contains 
tions and controls for displaying or manipulating the file.

u can share media files in either of two ways:

In a Microsoft PowerPoint presentation: Using the WebEx Universal 
Communications Toolkit, a plug-in for Microsoft PowerPoint, you can 
insert UCF objects into your slides. You can then share the presentation 
during a meeting.You can download the Universal Communications 
Toolkit from the Support page on your Meeting Center Web site.

As a standalone file: You can share a media file directly in the content 
viewer. Meeting Manager creates a UCF object for the file automatically, 

Sharing graphics quickly

You can quickly share a graphics file 
your computer's clipboard, and then
To copy an image, do one of the follo

■ Right-click an image on a Web pa
Copy.

■ Capture the active window on you
PrtScn (Print Screen) key.

■ Capture your entire desktop to an
Screen) key.

After you copy an image to your com
menu in the Meeting window, choos

You can paste any bitmap image in th
JPEG, BMP, or TIF image. However, 
images—such as EPS or Adobe Photo
content viewer.

Optimizing attendees' sha

These tips can help you to avoid com
desktop, or Web browser sharing:
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 display mode is set optimally for the 
ou can choose one of two display 

ns and another for graphics-intensive 
ode, on the Meeting menu, choose 

eb browser with another window 
es cannot view the area of the 
 window covers. Instead, a 
vered area on attendees' screens. 
at you minimize all applications 
nd then restore the window for 
ou want to share. 

red view and create the 
mputer to join the meeting as an 
view of your presentation.

dees

ny types of files to attendees, by 
he following are some examples 

■ Provide attendees with a copy of your presentation or any other 
documents that you share during the meeting. 

w to install and use an application, 
tion's installation program. Then, use 

s how to install the software.

g, provide attendees with a copy of the 
endees can open a poll results file using 
proving the performance of software sharing

 improve the performance of software sharing, do the following:

Close all applications that you do not need to use or share on your 
computer. Closing applications conserves processor usage and memory on 
your computer, thus helping to ensure that Meeting Manager can send 
images of shared software quickly during a meeting.

To ensure that the maximum amount of bandwidth is available for 
software sharing, close any applications on your computer that use 
bandwidth, such as instant messaging or chat programs, and programs 
that receive streaming audio or video from the Web.

■ If you are training attendees on ho
provide attendees with the applica
desktop sharing to show attendee

■ If you take a poll during a meetin
poll results file that you saved. Att
any text editor.
N o t e  For instructions on setting screen resolution, refer to 
Windows online help.

You can also resolve some problems with screen resolution by choosing 
the View > Show Full-Screen View for Attendees command on the Sharing 
menu, which appears in the title bar of the application or Web browser 
that you are sharing.

To improve the quality of attendees' views of a shared application, ensure 
that your screen display and attendees' screen displays are set to the same 
color depth—for example, 16-bit color.

N o t e  For instructions on setting screen color depth, refer to 
Windows online Help.

unning applications before a meeting starts

 save time during a meeting, begin run any applications that you 
tend to share before the meeting's starting time, and then minimize 
eir windows. At the appropriate time during the meeting, you can 
ickly begin sharing an application, without waiting for the 

■ Ensure that the Meeting Manager
application that you are sharing. Y
modes: one for normal applicatio
applications. To set the display m
Options.

Avoiding blocked views

If you cover a shared application or W
on your computer's desktop, attende
application or browser that the other
crosshatched pattern appears in the co
To help avoid this problem, ensure th
that are running on your computer, a
only the application or browser that y

To ensure that you do not block a sha
crosshatched pattern, use a second co
attendee and monitor the attendees' 

Transferring files to atten

During a meeting, you can transfer a
choosing Transfer on the File menu. T
for using this option:
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■

Use the network-based recorder to easily capture all audio in your 
meeting’s teleconference, without having to use a phone recording adapter 

■

ture all audio that plays “through” your 
oIP conference or sound that media files 
n a traditional teleconference using a 
onnects your phone to your computer.

le only offline—that is, outside of an 
 you record all screen activity in any 
 then saves it in a recording file on your 

ate software demonstrations, tutorials, 
 capture audio in an application 
phone to your computer.

 recorder from your Meeting Center 

bEx Recorder and Player, refer to 
’s Guide.

ording that you made using 
move mistakes, long pauses, 
an edit any WebEx Recording 

Format (.wrf) file that was made using the WebEx Recorder.

To edit a recording, you must use WebEx Recording Editor, which is 
ck page on your Meeting Center 

your company’s Web site

 publish recordings that users 
hen, anyone who visits your Web 
ing them over the Internet. 
ecordings without downloading 
(a device that connects your phone to your computer’s sound card). 
However, if you want to capture audio in an Integrated VoIP conference, 
use the integrated meeting recorder instead.

Integrated meeting recorder

The integrated meeting recorder is available during an online meeting. 
This recorder captures screen activity and audio in a meeting, and then 
saves the recorded data in a recording file on your computer.

available on the Recording and Playba
Web site.

Streaming recordings on 

On your company’s Web site, you can
have created using WebEx Recorder. T
site can play the recordings by stream
Streaming allows people to play the r
them to their computers.
ecording, playing, and editing meetings

his section describes the various options for using WebEx recording to create 
video recording of all screen activity on your computer, including all 
teractions, sharing, and audio. In addition, it provides information on 
iting and streaming your recordings.

ecording meetings

 you want to record a meeting—for example, for a remote team in 
other time zone—you can record the meeting using WebEx 

ecorder. You can then publish the recording on your organization’s 
eb site or intranet. Members of the remote team can use WebEx 
ayer to replay the meeting at any time.

ebEx Recorder is available in these versions:

Network-based meeting recorder

The network-based meeting recorder is available during an online 
meeting. This recorder captures screen activity and audio on a WebEx 
recording server, thereby saving processor resources and hard disk space on 
your computer. The server automatically processes your recorded data, 
and then sends the recording file to your personal folder on your Meeting 
Center Web site.

Use the integrated recorder to cap
computer, such as an Integrated V
play. You can also capture audio i
phone recording adapter, which c

■ Standalone recorder

The standalone recorder is availab
online meeting. This recorder lets
application on your computer, and
computer.

Use the standalone recorder to cre
sales presentations, and so on. To
recording, simply connect a micro

You can download the standalone
Web site.

For detailed instructions on using We
the WebEx Recorder and Player User

Editing your recordings

Before you distribute or publish a rec
WebEx Recorder, you can edit it to re
unwanted segments, and so on. You c
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by using two computers. Use one computer to present information, 
and use the other computer to view the meeting as an attendee.

S

If
w
yo

A
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m
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ce, on the Teleconference page in 
ge Audio Options page in the 
ferencing option and Integrated 

ation about setting up a teleconference 
fer to the online Help on your Meeting 

rt

ber that they can call to receive 
 personnel. Having this phone 
attendees can fully participate in 

 meeting when they need help, 
 first slide in the content viewer, 
genda. 

elines

 smoothly, you can provide 
attendees with a list of meeting guidelines to follow. For example, you 
can specify how and when attendees can ask questions, request 
annotation control, request remote control, and so on. To provide your 

 option:

ify your guidelines in the agenda.

st slide in your presentation. Once 
 read the guidelines before the 
etting up a dual-mode voice conference

 your meeting requires only one-way audio—that is, a meeting in 
hich attendees listen to the presenter but do not speak themselves—
u can set up a dual-mode voice conference. 

 dual-mode voice conference includes both a teleconference and an 
tegrated VoIP conference. Attendees can choose to listen to audio 
ing either their phones or speakers attached to their computers. For 
ample, if joining the teleconference would require an attendee to 
ake a long-distance call, the attendee could use Integrated VoIP 
stead.

guidelines to attendees, choose either

■ When scheduling a meeting, spec

■ Include your guidelines on the fir
attendees join a meeting, they can
presentation starts.
 stream recordings, you can use Create a URL for Recording page on 
ur Meeting Center Web site. For more information, refer to the 
ecording and Playback FAQ” on your site. This FAQ includes a link 
 the guide Streaming Recordings on Your Web Site.

osting a large meeting

r meeting hosts

his section provides tips and techniques that can help you to host a 
eeting with a large number of participants more effectively.

uting audio

 you are using the integrated WebEx teleconferencing service, you can 
event distracting noises during a meeting by muting the audio for all 
rticipants in a teleconference. To do so, on the Participant menu in 
e Meeting window, choose Mute All.

sing two computers

 ensure that attendees can view shared presentations or applications 
operly, you (or the presenter) can monitor their view of the meeting 

To set up a dual-mode voice conferen
the Advanced Scheduler or the Chan
Quick Scheduler, select both a telecon
VoIP.

N o t e  For detailed inform
and using Integrated VoIP, re
Center Web site.

Providing technical suppo

Provide attendees with a phone num
support from your technical support
line available helps to ensure that all 
a meeting. 

To avoid having attendees interrupt a
provide your support number on the
in the header of each slide, or in the a

Establishing meeting guid

To help keep a large meeting running
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The following are tips for solving and avoiding some common 
problems that you may encounter when using your Meeting Center.

U

A
un
to
a 
th
co

peed connections

 phone lines and equipment in 
erience. If you suspect that such 

t your phone service provider.

ion—such as ISDN, DSL, T1, or 
 limitations or data loss. These 
P or a major hosting facility in 
 proxy servers to handle inbound 
 servers can reduce your 
 performance of Meeting Center.

ction and whether any problems 
se traceroute—a utility that 
n the Internet between your 
 computer. 

puter to test the connection 
puter that hosts your Meeting 

ams, point to Accessories, and then 
mand Prompt, depending on your 
e MS-DOS Prompt or Command 
g Center Web site’s URL, which has the 

tracert <your_organization_name>.webex.com

where <your_organization_name> is the name of your organization.

any hops—or routers—that data 
Center Web site, and the time it 
illiseconds (ms). On a good 
100 ms to reach its destination. If 
0 ms, your connection is slow. In 
mine where the data's path 
 problem by tracing the route to 
yahoo.com, and comparing the 
Meeting Center site.
sing a dial-up connection

ttendees who use dial-up connections to the Internet can avoid 
necessary delays in screen updates during a meeting by connecting 

 their local ISPs, rather than to their corporate servers. Connecting to 
corporate server can cause delays in receiving meeting data because 
e data must traverse a longer path, and thus is more likely to traverse 
ngested lines.

2 Press Enter.

The traceroute results indicate how m
must traverse to reach your Meeting 
takes for data to reach your site, in m
connection, data takes between 15 to 
the data's travel time is longer than 10
this case, examine the results to deter
became slow. You can help to isolate a
a well-known Web site, such as www.
results to those for the route to your 
esignating a chat moderator

hat provides a convenient way for attendees to ask questions during a 
rge meeting. To ensure that attendees receive timely answers to their 
estions, and to avoid interrupting the meeting, you can designate 
other attendee as a chat moderator. The moderator can answer 

tendees' questions in chat messages. At the beginning of the meeting, 
struct attendees to use chat to ask questions and to direct their 
estions to the chat moderator.

andling disruptive attendees

 prevent a disruptive attendee from taking control away from the 
esenter, be careful when granting privileges to attendees. If an 
tendee continues to disrupt a meeting, you can expel the attendee by 
lecting the attendee’s name on the Participants panel, and then 
oosing Expel on the Participant menu.

nce you expel an attendee, you can prevent the attendee from 
tempting to rejoin the meeting by choosing Restrict Access on the 
eeting menu.

olving common problems

Testing dial-up and high-s

If you use a dial-up connection, poor
your area may affect your meeting exp
a problem exists in your area, contac

Even if you use a high-speed connect
T3—you may experience bandwidth
problems may originate with your IS
your area. For example, some ISPs use
and outbound network traffic. These
connection speed and thus affect the

To determine the speed of your conne
exist with your connection, you can u
records the route that data traverses o
computer and a specified destination

To use traceroute on a Windows com
between your computer and the com
Center Web site, follow these steps:

1 On the Start menu, point to Progr
choose MS-DOS Prompt or Com
computer’s operating system.In th
Prompt window, type your Meetin
following format:
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2 Click Support.

Support contact information appears on this page.
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Providing feedback about this guide

If you have comments about this guide or other WebEx 
documentation, please send an email message to docs@webex.com. In 
your email message, please specify the section to which your comment 
applies. If you would like to receive a response to your comments, 
please include your name and contact information in your message. 
© 1997-2010 Cisco and /or its affiliates. A

WEBEX, CISCO, Cisco WebEx, the CISCO
are trademarks or registered trademarks of C
States and other countries. Third-party trade

Document version: 091506

roviding feedback to WebEx

t WebEx, we value your comments about our software products and 
cumentation. 

roviding feedback about Meeting Center

 provide feedback about Meeting Center you can send an email 
essage to feedback@webex.com.
learing your Web browser's cache

learing your Web browser's cache can improve your browser’s 
rformance, and thereby your meeting experience. To clear you 
owser's cache, follow the instructions provided in your browser’s 
line Help.

andling firewall problems

ur Meeting Center Web site sends and receives all meeting data 
rough port 80—your firewall's standard HTTP port. You need not 
en any other ports on your firewall. If port 80 is open on your 
ewall but you still cannot use your Meeting Center Web site, please 
ntact technical support.

ontacting WebEx

btaining assistance

 receive technical support for Meeting Center, go to the Support page 
 your Meeting Center Web site, as follows:

On the navigation bar, expand Assistance.
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